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1 General  

 Foreword 

The operating instructions serve for a better understanding of the software program. It is 
imperative that the user is familiar with the operating system used and its standard func-
tions. 
In many examples in these operating instructions, the functions are only shown for analog 
values; the functions also apply analogously to digital values. Since many elements are 
interlinked within the application, the manual should be studied in its entirety. 
Within the manual, important passages are marked by the following element: 
 

 

Note! 
The symbol marks useful additional information and user tips. 

 
On the website https://www.hesch-automation.com/en/products/multifunction-controller/ 
there is an FAQ area for registered users, which covers both the software and the hard-
ware. 
 

 Product description 

The EasyTool MFC software program is used to configurate and parameterize various 
hardware platforms with the EasyTool MFC runtime system. The tool supports the follo-
wing hardware-specific configuration options: 

 Creation of user-defined operating pages, which serve for the individual configura-
tion and operation of the target system 

 Creation of user-defined programs / applications based on various basic libraries 
and their wiring 

 Test of the operating structure and the program in the form of a device simulation 

 Diagram-oriented online display of process values to support program testing and 
commissioning 

 Debugging of the program to test the entire application 
 

 System requirements 

Recommended operating system: Windows 7 or higher. 
  

https://www.hesch-automation.com/en/products/multifunction-controller/
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2 Initial program start 

After EasyTool MFC has been installed on the computer, the software is ready for opera-
tion. It is not necessary to enter a license number. 
 
To transfer a created project to the HE 5697 MFC, you need a USB dongle (license key). 
The dongle is available at AXXERON HESCH electronics GmbH. 
 

 
Figure 1 License key 

 

 USB-Dongle 

If the USB dongle is not inserted when the program starts, the software requires a restart 
to transfer a project to the HE 5697 MFC after the USB dongle has been inserted into any 
USB port on the computer. 
 

 
Figure 2 Warning message at program start 
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3 The structure of the EasyTool MFC 

The tool itself is based on the standard operation of modern software programs and essential-
ly supports all standard functions in the area of program operation. The individual items of the 
main menu and the project menu are briefly described below. Most of the functions are addi-
tionally addressed in later chapters and described in more detail. 

 

 The main menu 

The main menu is divided into five menu items and supports the operator in his general 
work with the tool. 
 

 
Figure 3 Main menu 

 
 The main menu item "File" 

The following actions can be carried out in the main menu item File: 
 

 
Figure 4 File Menu 

 

 The menu item New creates a new project. 

 The menu item Open browser dialog. 

 The Save menu item is used to save the current project. A standard file browser 
dialog is opened for saving. After the one-time assignment of a project/file name, 
all project changes are saved to the same file when the menu item is activated 
again. The saved file contains all the information required for use with EasyTool 
MFC. Possibly used image files are contained in the project file. 

 The menu item Save as is used to save the current project under a different 
name. A standard file browser dialog is opened as well. 

 The menu item Recently Opened Files contains a list of the most recently edited 
project files. 

 The menu item Exit terminates the EasyTool MFC. 
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 The menu item Export loader file (software version 1.4 and higher) enables the 
user to export the project for the "EasyLoader MFC" (file extension *.ctl). 
The exported project can be protected with a password (as an option), which pro-
tects the project from unauthorized editing and reading. 
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 The main menu item Edit 

The following actions can be done in the main menu item Edit. 
  

 
Figure 5 Edit Menu 

 

 The menu item Cut is essentially identical to the standard operating system func-
tion Cut. You can cut (remove) block elements, text elements, and elements from 
the area of the screen editor. Multiple selection is allowed.  

 The menu item Copy is essentially identical to the standard operating system 
function copy. You can copy block elements, text elements, and elements from 
the area of the screen editor. Multiple selection is allowed. 

 The menu item Paste is essentially identical to the standard operating system 
function paste. Elements that have been edited using the Cut or Copy function 
can be pasted again at permitted positions in the project using the Paste function. 

 The menu item Sequence is used to define the sequence in which functions from 
the project are processed (calculated). The sequence is indispensable for the cor-
rect execution of the project and is discussed in more detail in the chapter on pro-
ject creation. 
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 The main menu item View 
In the main menu item View you can switch between the individual project-specific parts / 
views of the project menu. In addition, the currently selected views marked by a check 
mark. The description of the entire project menu is given in the chapter 4. 
 

 
Figure 6 View Menu 

 
 

 The main menu item Device 
The following actions can be carried out in the main menu item Device: 
 

 
Figure 7 Device menu 
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 The menu item Data to device is used to transfer a project to the target system 
(device or simulation).  

 The menu item Data from device is used to transfer an already created project in 
the target system (device or simulation) back to the EasyTool MFC. 

 The menu item Parameter from device is used to transfer the block parameters of 
a project that has already been transferred and is currently open in EasyTool 
MFC. 

 The menu item Set password is used to assign a project password, which is later 
required for transfer to the target system or to the EasyTool MFC. Thus, projects 
can be protected against access by unauthorized persons.  

 The menu item Debug is used to switch the debugging function of EasyTool MFC 
on and off. 

 The menu item Firmware is used to update the device firmware as well as to sup-
port firmware tests or reset functions.  

 

 
Figure 8 Menu item Device ► Firmware 

 
 The main menu item Extras 

The following actions can be carried out in the main menu item Extras: 
 

 
Figure 9 Menu Item Extras ► Language 

 

 The Language menu item (Figure 9) is used to select the language for the 
EasyTool MFC. After the selection has been made, EasyTool MFC is prompted to 
restart. Language switching only works after a restart. If the prompt to restart is 
ignored, EasyTool MFC continues to work with the previously selected language. 

 The menu item Device languages (Figure 10) opens the dialog Device languages.  
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Figure 10  Menu Item Extras ►Device Languages 

 
 

 The main menu item Help 
The following actions can be carried out in the main menu item Help: 
 

 
Figure 11 Menu Item Help 

 

 The menu item Licence displays the licence type and dongle serial number. 

 The menu item Info about... is mainly used to display the EasyTool MFC software 
version number. 

 

 
Figure 12 Info window 
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 The views 

Various EasyTool MFC user areas are used to create and edit a project.  
 

 
Figure 13 The views 

 
The individual areas of EasyTool MFC are described in more detail in the chapter 4. 
 

 The selection menu 

The selection menu provides quick access to frequently used functions in the 
EasyTool MFC. 
 

 
Figure 14 Selection menu 

The functions of the individual menu items are explained in the chapter 3.1. The following 
functions can be selected from the selection menu: 
 

Symbol Function 

 
File / New 

 
Open file 

 
File / Save 

 
Edit / Cut 

 
Edit / Copy 

 
Edit / Paste 

 
Device / Data to the device 

 
Device / Debug 

 
Recorder 

 
Zoom back (only in online view) 
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 Setting the working area 

 User-defined windows in the function chart 
It is possible to add additional windows (functions) to the area of the function chart. To do 
this, the mouse must be placed on a frame of a window, for example a library. After 
pressing the right mouse button, a selection menu appears (see Figure 15). 
 

 
Figure 15 Window selection menu 

 
Here, an additional function such as Input/Output can be selected with the left mouse but-
ton. The additional function appears at a new location within the function chart. The 
placement of the new window can be changed by moving it with the pressed left mouse 
button. It is also possible to superimpose windows (see Figure 16). 
 
 

 
Figure 16 Docked window arrangement 
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In addition, the windows can also be placed "freely" over the function chart (see Figure 
17). 

 
Figure 17 Free window arrangement 

 
This type of window arrangement and function extension is possible in all project areas. 
 

 Device languages 

As of software version 1.5, the device language can be changed as required. 
The function is explained step-by-step below. 
 

 Configuration of the Language Scope 
The menu command Extras ► Device Languages opens the dialog Device Languages 
(see Figure 18). 
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Figure 18 Dialog Device languages 

Element Function 

 
Add a new language to the project 

 
Delete a language from the project 

 
Change the order of languages 

 
Edit the Property of a Language 

 
 Adding a language 

 

Press  to add a new language to the project. The language selection dialog box ap-
pears. 
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Figure 19 Language Selection Dialog Box 

The (mostly European) languages can be selected from the list. If the 

desired language is not included in the list, it can be selected via the dialog button   
Add language see Figure 20. 
 

 

 
Figure 20 Add Language Dialog 

Element Function 

Name Unique name of the language within the project 

Language Text which appears under Language Scope 

Device text Text which is displayed during language selection 

Flag 
Flag is any image that is displayed in the tool and in the language se-
lection. The optimal size of the image is 45 × 30 pixels. 
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 Export of language files 
In the Device languages dialog, a language file can be exported as a CSV file via the 
"Export" button. The following dialog allows you to specify the languages of this file: 

 
Figure 21 Export Dialog 

Element Function 

Source language Language used as a basis by the translator 

Target language Language to be created by the translator 

 
 The translation 

The exported language file is translated in Excel. Please note the following when opening 
the file. 
If the file is opened by double-clicking, it is not displayed correctly formatted (see Figure 
22). 
 

 
Figure 22 Unformatted file view in Excel 
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This ensures that the data is formatted correctly: 
1. Select column A 
2. Select "Text to columns" in the Data menu. The text conversion wizard opens. Click 

"Next ". 
 

 
Figure 23 Excel Text Conversion Wizard Step 1 of 3 

 
3. Select "Semicolon" as separator and click "Next". 

 

 
Figure 24 Excel Text Conversion Wizard Step 2 of 3 
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4. In the following dialog, select "Standard" as the data format for the columns and then 
click on "Finish”. 

 

 
Figure 25 Excel Text Conversion Wizard Step 3 of 3 
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5. The data is now displayed correctly and the translation can be done in column C. 
 

 
Figure 26 Excel file view after text conversion 

 Importing language files 
Once the translation has been completed, the language file can be imported in the Device 
languages dialog via the "Import" button.  
When importing, only those texts are imported whose unique identifier (column 1) match-
es the texts in the project. 
 

 

Note! 
The file must be in the same CSV format as it was exported, EasyTool 
cannot import files in Excel or OpenOffice format. The target language 
defined in the CSV file must be included in the language scope of the 
project, otherwise an error message will be displayed. 

 
 Language overview 

 
In the "Device Languages" dialog, the "Overview" button can be used to open a dialog 
with a table in which all texts in all languages can be displayed and also changed. 
This function is used to check whether all translations are complete and to quickly change 
individual texts. In the table, the fields with the changeable texts are highlighted in color. 
The fixed device texts in German and English as well as the texts in the project language 
cannot be changed. 
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 Function block "LANG"  
In the library under "Additional Functions" there is the new block "LANG", which can be 
used to set and query the device language. 
The language can be set via the analog input "dl" (Device Language). The input only re-
acts to changes so that two-point operation is possible. (Change via the function block, 
change via the "Settings - Language" menu. If the input remains unwired, language 
switching is performed exclusively via the language menu. 
The values of the input correspond to the order of the active device languages in the lan-
guage scope. If "German, English, French" is defined there, a 1 causes a switchover to 
German, 2 to English and 3 to French. All others are ignored. 
The input values are arithmetically rounded. 
The currently effective language can be queried via the analog output "dl". 
 

 HMI Element "Language"  
The new "Language" element is located in the HMI library. With this element a language 
switching on a user side can be realized in a simple way. 
The parameters of the "Appearance" category correspond to those of the "Text" control. 
In addition to the text, a country flag is added. In the screen editor of EasyTool this is 
fixed according to the set language of the tool. The device will display the country flag 
matching the currently effective national language. 
The "Text" parameter can be empty, in this case only the country flag is displayed. If the 
text parameter contains the keyword "%{LANGUAGE}", this is replaced in the device by 
the name of the currently set language. 
 

 Other information 
All language information is stored in the project file by the tool. This also includes the self-
defined languages with the image file for the flag. This makes it possible to transfer the 
project file to another user and be sure that he has all the necessary information. 
The language files in CSV format are only required for the translation process. Although 
they are not needed for the further work with the project and the download into the de-
vice, it is useful to archive them so that the translations are not lost, e.g. because the pro-
ject file was changed or damaged. 
If a text is added in the project, then the translations that have already been carried out 
are also exported when the language file is exported, so the new text is easy to find be-
cause the corresponding field in the target language is empty. 
If a text is changed in the project and translations already exist for this text, the transla-
tions are deleted because they no longer match the text after the change. 
 

 Language menu in the HE 5697 MFC 
The menu item "Language" is located in the main menu of the HE 5697 MFC under "Set-
tings". As of version 1.4 you can set the fixed languages German and English. The lan-
guage setting only affects the main menu and the parameters. As of version 1.5 the menu 
contains all languages defined in EasyTool under Device Languages. In addition to the 
text, the corresponding country flag is displayed.  
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Figure 27 Screen view HE 5697 MFC Language 

 HMI Element Language 
The element displays the country flag of the currently set language, as well as any addi-
tional text. 
Touching this screen item displays the language menu from the previous chapter. 
 

 
Figure 28 Screen view HE 5697 MFC Language selection 

 
 

 

  



Chapter 4: The Views in Detail 
 

Operating Instructions EasyTool MFC | Version 1.8    25 

4 The Views in Detail 

The different views serve to select all project planning areas which are necessary for the 
creation of a project. The selection can also be made via the View main menu. The individual 
areas are described in the following chapters. 

 

 "Projects" View 

The project menu shows an overview of the most recently edited (opened) projects. Fur-
thermore, it is possible to create a new project or to open the last used project folder.  
 

 
Figure 29 Project Menu 

 
The selection is made by clicking with the left mouse button. After selecting a new project 
or an already existing project, EasyTool MFC switches to the area of the function chart.  
 
If "Open project" is selected, a standard file browser is opened for selecting a project. Af-
ter selection, EasyTool MFC also switches to the area of the function chart here. 

  



Chapter 4: The Views in Detail 
 

26  Operating Instructions EasyTool MFC | Version 1.8 

 Function Chart View 

The function chart provides all the functions required for creating the application (se-
quence program). 
 

 
Figure 30 View of function chart (factory setting) 

 
In addition, the function chart also offers the elementary functions for testing the applica-
tion in simulation as well as extensive debugging functions.  
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 The Editor Window 

The editor window (yellow background) is used to create / draw the entire process se-
quence. The drawing field itself has an almost unlimited size and can be zoomed in and 
out using the zoom function (+/- keys or scroll function of the mouse). This makes it pos-
sible to display the entire process flow in a single display. However, this procedure only 
makes sense for the smallest processes. For larger process flows, you should use the 
structure help "Structure block" (see 4.2.9). 
 

 Typical Editing Functions in the Editor 
Within the editor window, standard operating system functions such as ("Copy & Paste"), 
cut, select (also multiple selection) and move can be used. For this you can use the key 
combinations of the operating system (e.g. Ctrl+C for copying with Windows) or the 
EasyTool MFC functions described in chapters 3.1.2 and 3.3. 
 

 Help in the Function Chart 
The FB Help window describes the selected function from the library area. 
 

 
Figure 31 Example: Help for the "LEAD" time function 

 
 The Simulation in the Function Chart 

The simulation in the function chart is used to test the application without using the target 
system. Within the simulation, the target system can be operated as far as possible in the 
same way as the original target system. The simulation of physical inputs and outputs is 
also possible in the Function Chart view, but requires the display of an additional window 
(see chapter 3.4.1). It is a good idea to simulate a system with many inputs and outputs in 
the Simulation area. 
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 The Function Block Libraries   
The function block libraries provide all functions that can be used within the application. 
The libraries depend on the target system used. Therefore, not all of the libraries shown 
in this documentation are always available. 
 

 
Figure 32 Function chart libraries  

From software version 1.4 there is a filter input field in the FB library. This facilitates the 
search for corresponding function blocks. By entering a text, the display of the library en-
tries is filtered accordingly. It searches for library names as well as block names and block 
types.  
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 Selection and placement of functions 
The selection of the individual functions from the libraries is carried out with the help of 
the pressed left mouse button. After selecting the function from the Library window, the 
function can be dragged to the yellow drawing area by holding down the left mouse but-
ton. The placement is done by releasing the left mouse button (Drag and Drop). The 
placement can be changed at any time afterwards. This can be done by selecting the 
function with the left mouse button and pressing the left mouse button. Multiple selection 
is possible with the standard operating system options (widen frame with mouse + Ctrl 
key). Only selected functions can be moved. 
After the placement and also at any later time, an application-oriented name can be as-
signed to the function block. For this the function block must be selected with the right 
mouse button and the “Rename" menu selected with the left mouse button.  
 

 
Figure 33 Assign block names I 

A new name can be assigned to the block in the now opened dialog. Press the OK key to 
accept the name. 
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Figure 34 Assign block names  

 

 

Note! 
The assignment of a new name changes the block size and thus affects the 
display and possibly the visibility of other elements. Individual names should 
therefore be assigned immediately after the placement. 

 

The functions differ in the coloring in relation to their use within the application. 

 Standard Function Blocks  

 Process variables (sources and sinks)  

 HMI variables (variables for operation)  

 Structural blocks  

 Forcing blocks  
 
The individual functions and parameters of the different blocks are described later in the 
manual.  
  

 The parameters of functions 
The function of blocks can depend on parameters, depending on the version. The param-
eters themselves are contained in the description of the blocks. To change a parameter of 
a block, the parameter dialog must be opened. This is done either by double-clicking the 
function block with the left mouse button or by selecting the function block with the right 
mouse button and selecting the parameter dialog with the right mouse button. 
 

 
Figure 35 Selection Block Parameter dialog 
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Figure 36 Parameter dialog 

The parameters of the function block can be selected by double-clicking on the value of 
the parameter (yellow field) and be adjusted by keyboard input or selection. The parame-
ters of the block are only accepted after confirmation with the OK key.  
 

 

Note! 
The parameters are not transferred to the target system at this time, even if 
it is connected to EasyTool MFC. 

 
 Connecting functions 

In order to establish the function of the application, it is essential that the individual func-
tions are connected with each other. The function blocks are connected to each other 
with the mouse. The first step is to select the block that forms the signal source with the 
left mouse button and move the mouse pointer to the signal source (one of the block out-
puts). The output must be marked "green" for wiring (see Figure 37) 
 
 

 
Figure 37 Wiring of blocks I 

 
With the left mouse button pressed down, a wiring line can now be drawn from the output 
in the direction of the signal sink (input at the target block) (see Figure 38).  
 

 
Figure 38 Wiring of blocks I 

 
When the input of the target block is reached, this is marked "green". If the left mouse 
button is now released, the connection has been made (see Figure 39). If the connecting 
line disappears after releasing the left mouse button, the input of the target block was not 
selected. 
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Figure 39 Wiring of blocks III 

 

Note! 
A connection is only possible between inputs and outputs of the same type. 
Block functions are available for converting signal types (analog / digital). 
These are contained, for example, in the "Signal converter" library. 

 
 The structure of the application 

The structure of the application is an essential component for readability and later exten-
sion as well as problem search. Although the function chart offers the option of creating 
the entire application (process flow) on an editor sheet, this inevitably leads to confusion 
in larger processes.  
The structure blocks allow the application to be divided into areas such as zones, in-
puts/outputs, rooms, trades or other logical parts for the process. 
All blocks necessary for the use of structures can be found in the library "Block functions".  
 

 
Figure 40 Library "Block functions"   
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The structure block provides the essential function. After placing the structure block, it 
can be renamed like any other block. The structure block can then be opened by double-
clicking the block. You can now see an empty editor window, which can be used like the 
main editor window. The active structure is displayed in the Structure window. The cur-
rently displayed structure is highlighted in gray. You can use other structure blocks in a 
structure block. The individual structures are then all displayed in the Structure window 
and can also be selected in this window with the left mouse button (see Figure 41). 
 

 
Figure 41 Structures in the Function Chart 

 
It is also possible to paste a structure block in the editor window. When pressing the right 
mouse button in a free area of the editor window, a menu with the option of placing a 
structure block appears. 
Structure blocks can be connected to other structures using inputs and outputs of a struc-
ture or with connection functions (see 4.2.10). The inputs and outputs of the structure are 
also part of the library Block functions. To provide a structure block with inputs and out-
puts, the analog and digital inputs/outputs from the Block functions library must be placed 
in the editor. Like any block, these can be given a name and automatically appear as 
connecting elements on the structure block. 
 

 
Figure 42 Inputs and outputs for a structure block 
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Figure 43 The inputs and outputs of the structure block 

 

 
Figure 44 Structure blocks in the application 

 

 

Note! 
You can exit a structure either via the Structure window (right-click to select 
another structure), or by pressing the right mouse button in a free space 
within a structure. In this case EasyTool MFC changes to the next higher 
structure. 

 
 The connection functions 
Within an application, it may happen that the connection of blocks is not possible due to 
long lines or that the legibility of the application is impaired. In this case there are connec-
tion blocks (data sources and data sinks). The required blocks can be found in the Varia-
bles library and differ according to data type, source and sink. The blocks can be placed, 
wired and renamed like standard function blocks. Fig. 45 shows how the connection be-
tween source and sink is established without a direct connection line. The example is of 
course nonsensical, but is intended to illustrate the principle of how a variable can be 
"transported" without a connecting line.  
 

 
Figure 45 Source and sink (used as an example) 

Source and sink can be used both within an editor window and between any structure 
blocks. 
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 Communication with operation and visualization 
The function chart area can exchange data with the screen area (operating & visualizing) 
via various functions. To access data from the screen area to the function chart area, the 
data connections from the "HMI variables" library must be used. The HMI blocks can be 
used like all other blocks. After placing an HMI block, the data is available in the screen 
area (see 4.5) or data from the HMI can be used in the function chart. 
 

 
Figure 46 Use of HMI variables 

 

 

Note! 
When using the HMI variables, pay attention to the direction of action. An 
input to the HMI "transports" a value from the application to the HMI. An 
output gives the possibility to change a value in the HMI and to "transport" it 
to the application. 

 
 Debug functions 
The debug functions are an essential component for testing an application and its opera-
tion. In addition, they are an aid to facilitate commissioning for larger applications.  
The functions are contained in the library "Debug functions" and can be used like all other 
blocks. The functions can be used to display values within the application but also to ac-
tively change values within the application. To be able to use the debug functions, the 
project must first be transferred to the simulation (main menu Device ► Data to device or 

the symbol key ). The debug mode can then be started (main menu Device ► Debug 

or the symbol key ). If the debug mode is active, the background color of the editor is 
switched to light green. 
 

 

Note! 
As long as the mode is active, no drawing actions are allowed. To return to 
the drawing mode, the debug mode must be terminated by selecting the 
Debug function again. The editor changes the background color back to 
yellow. 
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Figure 47 Exemplary use of debug functions 

The debug display functions become active immediately after switching on the debug 
mode. The forcing functions must be activated while the debug mode is switched on. All 
you need to do is double-click the forcing block. A prompt appears in which forcing is ac-
tivated (tick "Active") and the forcing value can be entered. 
 

 

Note! 
The forcing functions remain active if the debug mode is exited and they 
have not been deactivated before (check mark "Active" is not set). The 
forcing functions remain active or inactive until the next time an application is 
sent to the target system, depending on the last setting. 

 
 Additional functions / Device functions 
The libraries "Additional functions" and "Device functions" contain functions around the 
target system.  

 The LED block is used to control the LEDs of the target system 

 The "Key" block is used to evaluate the control buttons of the target system 

 The block "Clock" contains all values around date and time 

 The "Trend" function is used for recording and displaying hydrographs on the tar-
get system. The diagram pages in the target system can be accessed via the HMI 
or via the text-based operating menu in the target system. 

 The function "CONST" offers the possibility to use constants within the applica-
tion. The constants can be changed via the parameters of the block. 

 The "RELAIS" (RELAY) function is used to activate the relays of the target sys-
tem.  
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Figure 48 Additional functions 

Fig. 56 shows two of the special functions and the representation of the hydrograph in the 
simulation.  
 
 The Sequence of Processing 
In many cases, the sequence in which function blocks are processed plays a decisive 
role. In order to ensure that a certain sequence is adhered to, the sequence can be de-
fined. To set it, you need to activate the "Sequence" function (menu: Edit ► Sequence).  
 

 
Figure 49 The block sequence 

  



Chapter 4: The Views in Detail 
 

38  Operating Instructions EasyTool MFC | Version 1.8 

If the sequence does not correspond to the requirements, it can be changed by clicking 
on the sequence number (number highlighted in orange). The first sequence number 
(block) selected after activation is assigned the number one. The editing of the sequence 
can be terminated by selecting the "Sequence" function again (menu: Edit ► Sequence). 
The sequence is defined separately for the main editor and all structures. Of course, the 
structure blocks also receive a number for the sequences.  
 

 

Note! 
If the sequence is not specified, the blocks are numbered according to their 
order of placement. 

 

 "Programs" View 

The view Programs is intended for the configuration of the program editor. The program-
mer can execute 20 programs each with 60 segments (program steps). 
 

 "Menu" View  

The Menu view allows the user to configurate the text-based parameterization in the tar-
get system in a user-oriented way. Thus, the operator will later only have the parameters 
available which are useful for the use and not all parameters of all blocks. 
 

 " Screen" View  

The Screen view supports the entire editing for visualization and operation of the target 
system. 
 

 
Figure 50 Screen editor (factory setting) 
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The factory setting can be extended by functions like any other area (see 3.4.1). In the 
case of the screen editor, it may be useful to add the simulation function to get a first 
quick impression of the visualization and operation without using the Simulation area.  
 

 The operating pages 
It is possible to create user-defined operating pages for the target system. The pages 
must be designed so that the operator is able to control and operate the entire applica-
tion. The operating pages that are loaded into the target system can be seen in the 
"Structure" overview. This structure is empty for a new project. The first operating page 
can be created in the "Structure" area using the right mouse button. A menu with "Add 
screen“ appears. 
 

 
Figure 51 Add screen 

By selecting the dialog a new screen with the name "Screen 1" is created. By selecting 
this new screen in the Structure area with the right mouse button, it is possible to give the 
screen a unique name or to delete the screen. The same functions are available to add or 
remove additional screens from the application. 
 

 
Figure 52 Edit screen 

 

 

Note! 
The order of the screens does not matter, since the call is made via the 
visualization elements and is therefore completely user-oriented. 

 
Each screen has, in addition to its name, two parameters: the background color (selection 
via the three dots after clicking with the right mouse button) and the option to select an 
image as background. For the selection and the import of the image see the element 
„Image“ in chapter 4.5.2.  
To change the operating pages during later editing, simply select the desired page with 
the right mouse button in the Structure area. For example, elements can be easily copied 
from one operating page to another.   
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 The visualization elements   

The structure of the visualization and operation is supported by elements in the library 
(window library). All elements have parameters which influence the function and display 
of the elements. The parameters in this chapter are identified by quotation marks. The pa-
rameters of an operating element are displayed in the Parameter window and can either 
be entered directly or must be selected via an additional menu. This menu can be opened 

by right-clicking the button with the three dots  after selecting the parameter. After a 
selection has been made in the now opened dialog, the value is accepted by closing the 
dialog with "OK".  
All elements have in common that the position, size and color can be adjusted via the pa-
rameters. The color must take into account the specificity of the alpha channel. 
 

  
Figure 53 Dialog Menu "Color Selection" 

This appears in the "Color selection" dialog menu and sets the transparency of the color 
(255 = no transparency / 0 = no more color). 
The following elements are available: 
 

 
Figure 54 HMI Library Screen  
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Note! 
Values/variables can only be processed in the screen area for values that 
have been created as HMI variables in the function chart. 

 

 

Note! 
In the installation directory, the software provides images for creating the 
operating pages (see also chapter 4.5.7). 

 
Display 

 The element "Display" is used to display values; the display (text, colors) can be 
switched depending on a digital value "State". The value to be displayed is select-
ed with the parameter "Text variable" (key with three dots). The type of display 
can be adjusted for both states with the "Text" parameter. The value itself is dis-
played in the text by the entry "%.1f". The display of the value can be adjusted 
with respect to the decimal places by changing the number in the entry "% 1f". 
The "1" stands for one decimal place. For example, if a "0" was entered, no deci-
mal place would be displayed. A text behind and or before the entry "%.1f" is pos-
sible. The display element also supports this function: 

o Hiding the display depending on a variable "Invisible" 
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Selector 

 With the selector module any analog value can be assigned to an AOUTH (analog 
HMI output in the function chart). This makes it possible, for example, to transfer 
preset offset values (5%; 10%; ...) to the function chart (the application). 

 If, for example, there is an application with different transport routes through a fur-
nace, this element can be used to give clear names to the different routes, such 
as "with cooling", "without cooling" instead of just a number. 

 In the example Figure 55 the selection list has 2 entries with fixed analog values 
for an HMI output. 
  

 
 
       
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 55 Example for the Selection element 

  

Selection list  
after pressing the 
selection key. 

.Selection switch. 
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Bar graph 

 The element "Bargraph " is used to display a bar which changes its size depend-
ing on a "value". The horizontal or vertical alignment is determined by the "Align-
ment” parameter, the width and height by the standard parameters of the proper-
ties. The values for minimum and maximum as well as the "Start value" of the bar 
graph can either be fixed with the parameters "Minimum", "Maximum" and "Start 
value" in the "Appearance" area or can be variably controlled via a value using the 
same parameters in the "Inputs" area. The control via the inputs has priority over 
the parameters from the appearance area. As an additional function, the bar 
graph can be used as a sensor (see also the "Button" element; the value to be 
changed is addressed via the status parameter (output). The "Bargraph" element 
also supports this function: 

o Hiding the bargraph depending on a variable "Invisible" 
o The blocking of the value change depending on a variable "Blocked"  

 
Picture 

 The "Picture" element is used to display images that must be imported into the 
EasyTool MFC. jpg, png and bmp formats are supported. The import as well as 
the selection of already imported images is done via the parameters "Image 1" 

and "Image 2". After selecting the image selection (button with three dots ), an 
import menu appears (see Figure 56). After selecting the import function, a stand-
ard file browser dialog is displayed. The graphic can now be searched for and im-
ported here. The graphic is then displayed in the import window  and can be se-
lected. The image element also supports these functions: 

o Hiding the diagram depending on a variable "Invisible" 
o The function of a sensor depending on a variable "State" (output) 
o Switching between "Image 1" and "Image 2" depending on a variable 

"State" (input) 
o Blocking the "Sensor" function and the screen change depending on a 

"Blocked" variable 
 

 
Figure 56 Diagram import window 
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Editor 

 The element "Editor" offers the possibility to display and change analog values 
"Variable" (output). The value is entered on the target system via a numeric key-
pad. The editor element also supports these functions: 

o Hiding the value depending on a variable „Invisible“  
o The blocking of the value change depending on a variable „Blocked” 

 
Form 

 The element "Form" can be used without value assignment as a pure drawing el-
ement, for example to create frames. If the element is used with a value "State"  
(input and output), the status of a digital value status 1 and status 2 can be dis-
played by changing the color (status input) or the digital value can be changed 
status (output). The "Form" element also supports these functions: 

o Hiding the form depending on a variable “Invisible“  
o Blocking the "Change value" function and the screen change depending on 

a variable "Blocked” 
o The "Form" element can take on three different forms using the "Appear-

ance" parameter 
 Rectangle 
 Rounded rectangle 
 Ellipse  

Switch 

 The element "Switch" is almost identical to the element “Button” with two excep-
tions: 

o The change between "State 1" and "State 2" remains after actuation until 
the switch is actuated again.  

o The switch does not support switching to another screen. 
 
Sensor 

 "Button" is used to change a digital value and/or to change the screen view. The 
button can be executed as plain text or as a graphic using the image parameter. 
The graphic is imported in the same way as the image element. The change be-
tween "State 1" and "State 2" takes place when the sensor is pressed. The "But-
ton" element also supports these functions: 

o Hiding the sensor depending on a variable "Invisible” 
o The function of a sensor depending on a variable "State" (output) 
o Switching to another screen "Screen". The selection is made by selecting 

the menu (button with three dots) and selecting the target screen. 
o Blocking the "Button" function and the screen change depending on a vari-

able „Blocked“. 
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Text 

 The Text element is used purely to display a text. The element provides parame-
ters for customizing the display of the text. The "Text" element also supports this 
function: 

o Hiding the text depending on a variable “Invisible“. 
 

 

Note! 
In EasyTool MFC, all fonts installed on the PC can currently still be used. Of 
course, not all of them can be displayed on the target system. Similar fonts 
are searched and used in the target system after sending the project. This 
applies to all text entries in the "Screen" area. 

 
The use of operating elements is analogous to the use of function blocks in the function 
chart. The element is selected with the right mouse button and dragged to the operating 
page with the right mouse button pressed. When the right mouse button is released, the 
element is placed. The later changing of the position is possible with the parameters of 
the element or with the mouse. 
 

 Overview of the operating elements used 
The "Elements" window shows an overview of all elements used in the currently selected 
operating page. This list makes it easy to select an element to edit. For this it is neces-
sary that the elements get a unique name after the placement.  
 

 The sequence of the operating elements on an operating page 
It is possible to determine the sequence of superimposed operating elements in order to 
intentionally cover certain areas. The sequence of the elements is determined by the se-
quence in the list in the "Elements" window. To change the order, the element to be 
moved must be selected with the right mouse button in the window "Element". A selection 
menu appears in which the element can be moved either "to back" or "to front”.  
 

 
Figure 57 Sequence of operating elements 

 
With this function, it is possible, for example, to assign a priority to alarm texts, which are 
superimposed in the same area of an operating page. 
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 Special parameters of the operating elements  

There are some special parameters in the "Screen" section that allow direct access to 
certain parameters of the target system. The parameters must be used instead of the 
"Text" parameter (factory setting usually %.1f). The following special parameters are 
available: 

 %{VERSION} = Version number, e.g. "1.0.146 Beta" 

 %{DATETIME} = Date and time, e.g. "8/19/2014 11:01:28" 

 %{DATE} = Date, e.g. "8/19/2014" 

 %{TIME} = time, e.g. "11:01:28" 

 %{STIME} = Time, e.g. "11:01" 

 %{SECONDS} = Conversion of a number of seconds into the time format 
"00:00:00" 

 %{INTERFACE1} = Information of the first interface 

 %{INTERFACE2} = Information of the second interface 

 %{INTERFACE3} = Information of the third interface 
 

 
Figure 58 Special parameters in the "Screen" area  

 
 Examples of operating pages 

By using the different operating elements, it is possible to create operating pages ranging 
from trivial simplicity to a professional presentation. The following illustrations show some 
possibilities for setting up operating pages. 
 

 
Figure 59 Example selection page 
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Figure 60 Example process picture 

 
Figure 61 Example operating page with left operating menu  

 
Figure 62 Example operating page with upper operating menu and 

alarm text 

 

Note! 
The degrees of freedom of the visualization should not be an approach for 
creating the operating pages more complex than necessary. The focus 
should be on user-friendliness. 



Chapter 4: The Views in Detail 
 

48  Operating Instructions EasyTool MFC | Version 1.8 

 
 Images for project creation 

To facilitate the project creation, the software offers some graphics in the installation di-
rectory, in the sub-path "Images", which can be used freely for the creation of the operat-
ing pages. 
Example: C:\Program Files (x86)\EasyTool MFC-1.2 SR1\Images\Palette1 
 

 
Figure 63 Supplied images in the installation directory 

 
When using other image/graphic material, the fol-
lowing recommendation should be observed. 
For ease of use, it is recommended to use the 
touch buttons not smaller than 40×40 px at a  

 resolution of 72 DPI. 
The adjacent figure shows the size ratio of two 
touch buttons on the device screen. 
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 View Online 

The online area makes it possible for the user to display selected values in tabular and 
graphical form during debug mode and is therefore a very helpful tool for testing the ap-
plication in simulation mode or later when commissioning the target system. 
 

 
Figure 64 Online view 

The values are selected by selecting the value in the "Values" area and moving the se-
lected value to the middle area while holding down the left mouse button. 
As soon as the debug mode has been started (this can be in any project area), the re-
cording starts in the online trend.  

The recorded data can be stored locally as *.csv using the function . However, this 
does not apply to the past from the time of recording.  
The scaling of the diagram is defined with the values "Upper limit" and "Lower limit". Exit-
ing the debug mode also terminates data recording in the online area. 
In the online view, the recorded trend can be zoomed in by expanding a frame. The pre-
requisite is the activation of the "Historical data". Zooming out is done step by step with 
the "Zoom back" tool . 
 

 

Note! 
The graphical display is deleted with the next start of the debug mode. If you 
switch between the project areas, for example to the function chart and 
back, the values are retained. 
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 View Simulation 

The "Simulation" area is used to simulate the application at the size of the target system. 
The simulation function is identical to the simulation in all other areas. This area is more 
suitable for systems with a larger number of inputs and outputs for simulation than the 
other process areas. 
Thereby, the function is identical to the simulation in all other areas. In general, all fields 
highlighted in yellow are suitable for input and thus values can be specified. All other 
fields are used to output process values. 
The input of analog values is done after selecting the field by double-clicking with the right 
mouse button. The digital values are activated by setting a check mark and can be deac-
tivated again by clicking again with the right mouse button. 
 

 
Figure 65 Simulation with a larger number of inputs/outputs 
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 Data Logger View 

Via the menu "View - Data-Logger" the log data stored on the device can be loaded into 
the EasyTool MFC and saved as *.csv on the computer.  
 

 
Figure 66 Selecting the Data Logger 

 

 
Figure 67 Data Logger View 

The communication window opens via the "Device - Data from device" menu . The type 
of connection must be selected there. "OK" confirms the selection and reads the directory 
on the MFC. A file selection is then displayed.  
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Figure 68 Data logger file selection 

"Open": Loads the log data to the Easy Tool MFC 
"Copy": copies the selected *.csv file(s) to the clipboard and then opens a dialog for saving. 
"Delete": deletes all selected log data on the device. 
"Exit": closes the dialog 
 

 
Figure 69 Display of the selected log data 
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 Block search view 

Via the menu "View - Block search" a window is opened which shows all blocks used in 
the project in a tree structure. Via the input field "Filter" blocks can be searched by their 
type or name. A mouse click on a block jumps to the position of the block in the function 
chart. 

 
Figure 70 Selecting Block search 
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Figure 71 Block search view 

 

 
 

By entering a search term, for example for all controllers "Contru", the selection is displayed fil-
tered. You can also search for assigned names. 
 
A click on the desired block leads to the target (see Figure 72). 
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Figure 72 Result of the block search 

 

  Cross-references view 

Via the menu "View – Cross reference" a window is opened which shows all sources with 
their assigned sinks, as well as HMI variables with their assigned controls. The variables 
can be searched for via the "Filter" input field. 
A mouse click on an element jumps to the position of the element in the function chart or in 
the screen editor. Alternatively, the cross-references window can also be opened via a con-
text menu of the variables in the function chart or screen editor. In this case, only the corre-
sponding element is displayed. The jump to the element by mouse click is done as de-
scribed.  

 
Figure 73 Right click on sources or sinks (HMI controls are also 

possible) 
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Figure 74 Example: Cross-references 

In Fig. 82 the cross-references are listed. A simple click on a branch takes you directly to 
the target. 

 

 
Figure 75 Second option "View – Cross reference" 

Analogous to the first method, the variable can now be selected and with one click you jump 
to the target. 
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5 Functional descriptions 

 Password allocation/ admission control 

As of software version 1.5 the password functionality is optimized. 
 

 „PASSH" function block 
This block can be used to determine the currently effective access level (analog output 
"level"). The value range is from 0 to 3. 
 

Via the analog input "level" either 

 the base level can be specified (parameter InpMode = "Base level". The base level 
is the level that is active after the startup or that is switched back to after a timeout 
has elapsed. 

 The access level can be specified (parameter InpMode = "Active level”. 
 

 Admission control mode selection 
When you select the "Operating pages" item in the HMI structure of the HMI editor, the 
passwords for the three levels can be set under "HMI parameters". 
These parameters are extended by a new item "Admission control" with the selection 
"Version 1" and "Version 2". 
If "Version 2" is selected, a new parameter "Timeout" appears. The timeout is defined in 
minutes, adjustable are the values 1 to 10, as well as "no timeout" are adjustable. 
 

 
 
In "Version 1" mode, all devices behave as before, i.e. admission control is only active for 
the "Button" screen element, and here only for switching screens.  
In "Version 2" mode, the new admission control becomes active for new devices. Fur-
thermore, the new parameter "Admission control V2" appears for all HMI elements except 
for "Display" and / "Text". The previous parameter "Admission control" is hidden from the 
sensor and is therefore ineffective. 
The admission control settings in the HMI elements are identical for both versions. 
 

 New HMI element "Display2"  
The element is derived from the current element "Display". 
It has 4 instead of 2 states, these are selected via an analog input instead of a digital in-
put. 
In addition to texts and colors, an image can be defined for each state. If image and text 
are defined, then the text is in front of the image (text background transparent). 
The element has the same outputs as the button element, i.e. "State" and "Screen". This 
makes it possible to use the element to adjust the access levels. 
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 New selection "Password dialog"  for "Button" and "Display 2" 

In these elements the selection "Dialog#Password" is additionally displayed at the screen 
output. This displays a dialog for managing the access level in the device. 
 

 Reaction when an HMI element is actuated on the device 
If an admission control (version 2) has been defined for an HMI element and the operator 
presses the element, the system first checks which access level is active. 
 
If the current level is greater than or equal to the level defined for the element, the action 
is executed immediately. 
 
If the current level is smaller than the level defined for the element, one of the following 
dialogs is shown. 
 

 
Figure 76 Screen display access level   

 

 
Figure 77 Screen display access level 
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Figure 77 shows if the function block "PASSH" is used and the parameter "InpMode = Ac-
tive level" is set. The access level is thus permanently set to the value of the analog input 
of the PASSH, the level cannot be changed. 
 
Figure 78 is displayed for all other configurations. By pressing the "Login" button and en-
tering a password, the access level can be set as required. The password is entered via 
the known number pad. The access level can also be reduced by entering a password. 
 

 
Figure 78 Number pad 

After changing the access level, the corresponding HMI element must be activated again. 
 

  Password-Dialog 
The dialog is used to centrally change the access level. You can use it to change to a 
higher or lower access level "Log in", or to change to access level 0 "Log off". 
 

 
Figure 79 Password dialog for "not logged in" state 

 
Figure 80 Password dialog for "logged in" state 
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The dialog in Figure 80 is displayed if you are currently in access level 0.  Fig. 89 shows 
the dialog in all other access levels. 
 

  Timeout 
In version 1 of the admission control, the password was requested at each screen transi-
tion, if this was defined for the corresponding button. In version 2, the password is re-
quested if the current access level is not sufficient. Once the access level has been suc-
cessfully changed, it remains effective and the password does not have to be re-entered. 
After a timeout has elapsed (see Tool, chapter 5.1.2, the access level either falls back to 
0 or to the value defined in the function block PASSH in the mode "Base level" (see Tool, 
chapter 5.1.1). 
The timeout time is restarted with each user action, i.e. each press of one of the four 
hardware buttons or each touch. 
 

  Compatibility 
If an old tool is used to load a project into a device, old and new devices behave as be-
fore, i.e. admission control version 1 is active. If a new tool is used to load a project into 
an old device, this will also behave as before, i.e. the admission control version 1 is ac-
tive, regardless of the selection of the admission control version in the tool. The new ad-
mission control is, if version 2 is selected, only effective in combination of new tool and 
new device. 
 
 
  



Chapter 6: Demo projects 
 

Operating Instructions EasyTool MFC | Version 1.8    61 

6 Demo projects 

In the installation directory of EasyTool MFC in the subpath "Examples" there are 
Prefabricated demo projects and a short description of the respective project. 

 
Example: C:\Program Files (x86)\EasyTool MFC-1.2 SR1\Examples 

 

 

Property Damage Warning! 
Demo projects included in the delivery serve to illustrate procedures 
and possibilities and do not represent a ready-to-use application solu-
tion. 
AXXERON HESCH electronics GmbH assumes no responsibility for 
damage caused by improper use of demo projects in applications. 
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